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Accessing Appointments 

Access the Appointments app from the New Appointments button on the main Vision 3 

menu. 

 

The app is designed for the front reception desk, offering quick intuitive functions for 

booking in patients, making/rescheduling appointments, along with inserting and 

deleting sessions. 

The back office functions such as extending books are carried out in Appointments 

Setup, or Vision 3 if you have not yet switched over. 

http://help.visionhealth.co.uk/Appointments_new/backoffice/1.0/content/home.htm
http://help.visionhealth.co.uk/Appointments_new/backoffice/1.0/content/home.htm
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Appointments Explained 

This section explains the different Appointments solutions within Vision and which 

version performs each function: 

 Vision 3 Appointments – The core Vision appointments module where 

historically you have managed all aspects of your practice appointments. 

 New Appointments App – The new intuitive Appointments solution from Vision. 

We are encouraging all customers to use this new app. 

 Appointments Setup – The new app allowing you to quickly and simply manage 

your appointments books. 

See - Appointments Setup. 

 Shared Appointments - Vision Data Hub – The unique solution used by 

federations and clusters to share appointments across organisations. This is also 

compatible with EMIS Web. 

See - Shared Appointments. 

 Online Services Patient Website – The patient facing website where patients 

can book, cancel and review their appointments. They can also request medication, 

view their patient record and send messages to your practice.  

See - The Hive for further information. 

The following table explains what you can and can’t do across the different appointments 

solutions: 

Function Vision 3  

New 

Appointments 

App 

Back Office 

 App 

Shared 

Appointment

s 

Online 

Services 

Patient 

Website 

Manage Appointments 

Bookings 

     

View shared Appointments 

across organisations 

    Patient 

website if 

configured. 

Configure shared 

appointments 

     

Set up new staff  – 
Control 

Panel 

    

Add new Book Owner *     

Create Session *     

Create weekly plan *     

Extend/Modify Books *     

Online Services *     

http://help.visionhealth.co.uk/appointments_new/backoffice/1.0/Content/Home.htm
http://help.visionhealth.co.uk/VisionDataHub/Appointments/Content/Home.htm
http://hive.visionhealth.co.uk/


  

8 

Appointment availability 

Online Services 

Appointments Configuration 

     

Run Appointments Reports      

Appointments Backup 
*     

* - If you have Appointments Setup enabled you can no longer do this in Vision 3, you 

have to use Setup. 
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Preferences Filter 

A default filter can be set for your Appointments view. 

1. Select the arrow next to your name at the top left of the appointments screen, and 

choose Preferences from the drop down list.  

 

2. Select the Filter tab. 

3. Select the drop down list and choose the required filter. 

 

The filter applies as a default view. 

4. Select the Back  button to navigate back to your previous view.  

Or if you want to undo what you have select the Reset  button. 

See - Preferences - General on page 10 and Preferences - Patient Data on 
page 13. 
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Preferences - General 

The user Preferences allow you to customise both the individual and practice settings. 

1. Select the arrow next to your name at the top left of the appointments screen, and 

choose Preferences from the drop down list.  

 

The General Tab displays, the settings here are practice wide settings.  

2. Timescale for slot retrieval 

 

 From - Set how far in the past the back arrow on Reception view displays. 

Choose from today - 7 days from the drop down list. 

This is the default period for the initial loading of the appointments app, you 

can go further back using the calender. 

Note - Any slot over 7 days old cannot be edited. 
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 To - Set how far forward you want the books to display. 

Select between To the end of the books and a time scale of 7 - 42 days in 

the future.  

3. Free slot definition 

 Unbookable Slots - Select to include free slots with a slot type that cannot 

be booked on the current day. 

 Overrun Slots - Select to include overrun slots in the free slot search. 

Note - The free slot definition affects the count in Free slot search. 

4. Slot Search Results Style 

 Calendar View 

A view of free slots by clinician. 

 

 List View 

Ordered by Start time or a Range of start times on the selected date.  
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 The Show Header Description for columns option displays the Owner and 

Session headings. 

5. Booking Appointments 

Tick the Show option to merge slots when an appointment overruns free 

slots to display the option to combine slots. 

See - Booking Multiple Consecutive Appointments on page 53. 

6. Once you have set your preferences, select the back arrow  to navigate back 

to the previous screen.  

Or, if you want to revert to system settings select the Reset  

button. 

See - Free Slot Search - Overview on page 55, Preferences - Patient Data 
on page 13 and Preferences Filter on page 9. 
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Preferences - Patient Data 

To access the Patient Data tab in Preferences: 

1. Select the arrow next to your name at the top left of the screen, and choose 

Preferences from the drop down list.  

 

2. Select Patient Data.  

The Patient data tab displays. 

 

3. Patient Information display 

Select to display patient recall information in the Patient Details view. 

4. Timescale for patient appointment data  

Choose from a date range from the last 3 months up to the last 5 years, to define 

the appointment history displayed in the Booking Form and Patient Details 

view. 

5. DNA Icon  
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Activate and define the number of DNAs in the last 6 months to trigger the alert in 

the Booking Form. 

6. Preferred spoken Language  

Defaults the filter selections to the spoken language preference of the patient 

when an appointment is made in the Patient view. 

7. Select the back arrow  to return to previous screen. 

Or, if you want to revert to defaults, select the Reset  button. 

Note - all of the settings within the Patient data tab in Preferences are practice wide. 

 

See - Preferences - General on page 10 and Preferences Filter on page 9. 
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Accessing Patient Details View 

The Patient view can be accessed in several different ways: 

Reception View 
From a booked appointment, hover on the slot to activate the Options menu to the right 

of the patient's name, and choose Open patient details from the drop-down list. 

 

Current Appointments View 
From a booked appointment, select the patient's name. 

 

Patient Select 

1. From the Reception view start typing the patient's name, and the search box 

displays.   
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2. Enter the patient's name. See - Patient Search Criteria on page 58. 

3. Select Search . 

The results display. 

4. Select the patient from the list. 

The Patient Details view displays. 

Booking Form 
Select the patient's name on the Booking form to open the Patient Details view. 

You can also select DNA/Scheduled/Completed or Cancelled buttons to view the 

relevant appointment history in Patient Details view. 

 

See - Patient Details View - Overview on page 24. 
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Patient Details View - Making Appointments  

1. Open Patient view. See - Accessing Patient Details View on page 15. 

2. Select Add Appointment  button.  

Note - The Add Appointment button is not available if you have accessed the 

Patient Details view via the Booking Form. 

The Reception view displays, with a selected patient message. 

 

3. Select an appointment. 

The patient details automatically populate into the booking form. 

4. Optionally, add any appointment comments and update the booking form. 

5. Select Book  button.  

A booking confirmation message displays. 

 

Note - If a suitable appointment cannot be found, the selected patient message box has 

a discard option to cancel the selected patient. 
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Integration with Vision 3 

Appointments 2.1 is integrated with Vision 3 through: 

 Consultation Manager 

 Registration Links 

Integration with Consultation Manager 
To open a patient's details in Consultation Manager, from the Reception view: 

1. Hover over the desired patient from the scheduled appointment list. 

2. Select Options . 

3. Select Open patient clinical record. 

 

4. The patient's clinical record displays in Consultation Manager.  

Integration within Registration 
To open a patient's details in the Registration module, from the Reception view: 

1. Hover over the desired patient from the scheduled appointment list. 
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2. Select Options . 

3. Select Open patient registration details. 

 

4. The patient's details display in the Registration module within Vision 3.  
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Patient Details View - Contact Details 

From the Patient Details view, you can add and edit a patient's Contact Details and 

Patient Notes.  

Add or Edit Patient Details 

1. Select the patient and open the Patient Details view.  

See - Accessing Patient Details View on page 15. 

2. Select Edit  in the Patient's Contact Details header to update or add 

contact details. 

3. Select an existing contact to update or add comments. 

To add a new contact, select from the Type drop down list. 

 

4. Enter/edit the number or email address.  

A red highlights displays, and the format detailed below. 

 

5. Optionally, enter/edit any Notes, for example, ring after 3pm. 

6. Select Add to record/update the contact. 

7.  Select Save  to complete. 

See - Patient Details View - Overview on page 24. 
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Patient View - Patient Notes 

The Patient Notes field contains recurring relevant information about the patient, this 

displays on all their appointments.  

For example, hard of hearing. 

Hover over the appointment to see the Patient Notes. 

 

To Add or Edit a Patient Note 

1. Open Patient Details view. See - Accessing Patient Details View on page 15. 

2. Select Edit  in the Patient's Notes header. 

3. Update or add the information into the free text box. 

 

4. Select Save . 

5. Select the  back arrow to return to the previous view. 

See - Patient Details View - Overview on page 24. 
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Patient Details View - Appointments 

The Patient Details view details an individual patient's future and historical 

appointments.  

Each heading in the Appointments section displays a maximum of 5 appointments, 

further appointments can be accessed by selecting the arrow >.  

The view is split into: 

  

 Future appointments  

 Past appointments 

 DNAs 

 Cancelled appointments  

The time frame for appointment history 

is defined in Preferences - Patient Data 

on page 13. 

 

  > Displays full history for the category.  
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Use the drop-down list to change the time period: 

 The last month 

 the last 3 months 

 the last 6 moth 

 the last year 

 the last 2 years 

 the last 5 years 

 the past 

  Select the back arrow  to returns to the Patient Details view. 

Edit Past Appointments 
When an appointment is more than 7 days old you are unable to amend the 

appointment.  

Prior to this, the appointment can be edited, select the appointment to access the 

booking form and update accordingly. 

See - Patient Details View - Overview on page 24. 
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Patient Details View - Overview 

The Patient Details view can be accessed via:  

 Reception view 

 Current appointments view 

 Booking Form  

 Patient Select 

 

Patient Banner 

 Date of birth 

 Gender 

 NHS/CHI Number 

 Preferred spoken language  

See - Spoken Language Alignment on page 27. 

 Demographics 

 Contact Details 

See - Patient Details View - Contact Details on page 20 

 Address 

 Registration Details 

 Patient Notes  

Recurring notes that display with each appointment. 

See - Patient View - Patient Notes on page 21. 

Appointments 

 Make an appointment 

 Scheduled appointments  

 Completed appointments  
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 DNAs 

 Cancelled appointments  

See - Patient Details View - Appointments on page 22. 

 

Note - The time frame for these is set in Preferences - Patient Data on 

page 13. 

Contacts 

 Next of Kin 

 Carers 

 Patients Cared For  

Recalls 

 Outstanding recalls  

See - Patient View - Recalls on page 26. 

 See - Accessing Patient View. 
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Patient View - Recalls 

To view a Patient's Recalls: 

1. Open Patient Details view. See - Accessing Patient Details View on page 15. 

2. Scroll across to the right of the screen where the last column displays the Recalls.  

Initially up to five recalls display. 

3. To view additional recalls, select Recalls >. 

 

4. Choose the back arrow to return to the previous view. 

Note - If you can't see the Recalls column it might be that it has been disabled in 

Preferences. See - Preferences - Patient Data on page 13. 

 

See - Patient Details View - Overview on page 24. 
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Spoken Language Alignment 

The Patient Details view displays the Preferred Spoken Language in the Patient 

Banner.  

 

When you make an appointment via the Patient Details view for a patient with a 

preferred spoken language, this aligns the clinician's spoken languages with the 

preferences. 

Note - This option needs to be enabled in Preferences. See - Preferences - Patient Data 

on page 13. 

1. Open the Patient Details view - see Accessing Patient Details View on page 15. 

2. Select Add Appointment . 

The Reception view opens. 

A selected patient message displays. 

 

3. The view automatically filters the patient’s preferred language against clinician's 

spoken languages. 

4. Select an appointment. 

The patient details populate automatically. 

5. Add any relevant appointment comments and patient related notes as required. 

6. Select the Save  button. 

Filters 
If you already have a filter set within Reception view, for example, Advance slots, the 

language alignment applies to the existing filter.  

Therefore, if your patient speaks Welsh, and you choose Add appointment in Patient 

View, the filter updates to Advance slots for a Welsh speaking GP. 

A filter remains until cleared by the user. 
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See - Patient Details View - Overview on page 24 and Apply or Edit Filters 
on page 80. 
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Weekly View 

To access the Weekly view: 

1. Select the drop-down arrow to the right of the Reception view. 

2. Select Weekly. 

 

3. The Weekly view screen displays. 

4. You can now choose a Clinician or Clinic and display their weekly view.  

 

From the Weekly view, you can: 
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 Navigate to a Clinicians weekly view, see Navigating to a Clinicians Weekly View on 

page 33. 

 Navigate to a Clinics weekly view, see Navigating to a Clinics Weekly View on 

page 35. 

 Add a session, see Adding a Session from the Weekly View on page 32. 



  

32 

Adding a Session from the Weekly View 

To add a session from the Weekly view: 

1. Select Options . 

2. Select Add session. 

 

3. The Add Single Session screen displays. 

4. Input all required information. 

 

5. Select Save . 

6. The session is added.  
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Navigating to a Clinicians Weekly View 

To navigate to the Clinicians weekly view: 

1. Select Clinicians . 

2. Select or search for the desired clinician. 

 

3. Their weekly view displays. 

 

 Select Options  to reveal additional options. 
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 Select  to return to the previous screen 
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Navigating to a Clinics Weekly View 

To navigate to the Clinics weekly view: 

1. Select Clinics . 

2. Select or search for the desired clinician. 

 

3. The weekly view displays. 

 

 Select Options  to reveal additional options. 
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 Select  to return to the previous screen 
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Appointment Views 

Navigating the Appointments views 
The default view is the Reception view, from here you can quickly access Current 

Appointments and Dashboard views. 

 

Reception View 
The Reception view displays all the clinician's sessions.  

 

See - Reception View. 

Current Appointments View 
The Current Appointments view is designed for quickly checking patients in. This 

displays appointments for the next hour and any DNAs from the previous hour, along 

with any patients waiting or in consultation. 

Once a patient has been seen, they are removed from the view. 
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See - Current Appointments View on page 40. 

Free Slot Search 
The Free slot search is accessible from the Reception view and is designed to show 

you only free slots, enabling you to quickly find available appointments. 

Filters can also be applied to refine the view, and you can also search by slot duration. 
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See - Free Slot Search - Overview on page 55. 

Dashboard View 
The Dashboard view shows at a glance where each clinician is up to in their session.  

 

See - Dashboard View on page 42. 
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Current Appointments View 

You can navigate to the Current Appointments  view from the Reception or 

Dashboard view. 

The Current appointments view shows all booked appointments within the next hour, 

DNAs from the previous hour, along with any patients waiting or in consultation. 

An appointment will show in this view if the status is: 

 Booked 

 Arrived 

 Waiting 

 In Consultation 

 Overdue 

 DNA 

The view is designed for quickly checking patients in. 

 

 Scroll up and down the Current appointments as required.  

 Select the patient's appointment status to increment, for example, check in a 

patient. 

A count of the waiting time displays until the patient goes into their consultation. 
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 Apply a filter to refine the view. 

See - Apply or Edit Filters on page 80. 

 Select outside of the view to close. 

Appointments Details 

 

 Select a patient’s name to access the Patient Details view.  

See - Patient Details View - Overview on page 24. 

 The appointment also displays Appointment Comments. 

 Right click on a booked appointment to change slot type, change status, move, 

copy or cancel. 

 Special bookings are indicated by a blue star. 

See - Appointment Status - Overview on page 77. 
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Dashboard View 

The Dashboard displays a high level overview of the appointments activity.  

To access, select Dashboard from the View menu in the top left corner of the 

Reception view. 

  

The Dashboard view maintains current the date from the Reception view. 

 

 Clinicians and Clinics- appointments summary. 

 Breakdown of slots - Seen, DNA, Waiting, In Consultation, Arrived and 

Free appointments.  

The colours on the screen follow the same format as the appointment status. 
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Colour  Definition 

Green Seen 

Blue In consultation 

Purple Arrived  

Pink Overdue 

Red DNA 

Grey Free Slots 

Empty white space  No clinic or session 
 

  

 Patients waiting and in consultation - count by clinician. 

  

 Patient Details - select the +Expand all option at the top of the column, to see 

which patients are waiting or in consultation. 

 

Use the View menu to return to the Reception view. 

See - Appointment Views on page 37. 
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Navigating the Reception View 

Hover over an appointment slot to activate the Options  menu, the content 

changes depending on how it is accessed and if the slot is free or booked. 

Booked Appointment - Left Click 

  

  

 Open patient details 

See - Patient Details View - Overview on page 24. 

 Cancel an appointment 

See - Cancel an Appointment on page 68. 

 Insert slot 

See - Insert Slots on page 73 

 Move appointment 

See - Move Appointments on page 75. 

 Copy appointment 

See - Copy Appointments on page 70 

 Change slot type 

See - Change Slot Types on page 69. 

 Change status 

See - Appointment Status - Overview on page 77. 

Booked Appointment - Right Click 
The right click option can be used on single or multiple appointments, the selected slots 

display in a pale blue highlight. 

 

The toolbar activates with the same options as the left click menu with the exception of 

Open Patient details which is not available. 

 

Free Slot - Left Click 

 
  

 Insert slot 

See - Insert Slots on page 73. 
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 Hold slot  

See - Hold Slots on page 72. 

 Change slot type  

See Change Slot Types on page 69. 

 Delete slot  

See - Delete Slots on page 71. 

 View Clipboard 

Free Slot - Right Click 
The right click option can be used on single or multiple appointment slots, the selected 

appointments display in a pale blue highlight. 

 

The toolbar activates with the same options as the left click menu, Insert slot is only 

available when a single appointment is selected. 

 

Session Heading 
  

 Select Free slots 

Selects all free slots, these can then be deleted / slot 

type changed. 

 Select booked slots 

All booked slots are selected and can then be 

moved/copied/slot type changed. 

 Delete Session 

Removes the session, and booked appointments move to 

the clipboard. 

This is not available if any of the appointments have a 

Seen or In Consultation status. 
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Filters 
The filter button is orange when active, hover over to display the filter details. 

 

See - Reception View, Book an Appointment on page 50, Apply or Edit 
Filters on page 80 and Appointment Status - Overview on page 77. 
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Reception View 

The Reception view opens on launching the Appointments app. 

This view displays the clinician and clinic sessions side by side, to show all appointments 

at a glance.  

Reception View Overview 

 

 AM or PM view 

 Date Selector - seven days 

 Calendar 

 Navigation Options - today, +1 to 6 weeks, previous week 

 Filter  

See - Apply or Edit Filters on page 80. 

 Free slot search  

See - Free Slot Search - Overview on page 55. 

 Scroll down or across to access more appointments 

 Appointment status - select status to check patient in or increment status 

 Events - display under the Clinician's name 

  

From the Reception view you can also navigate to the other views and access the 

Clipboard: 
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 View Menu - easily navigate to other views 

 Command Menu - add sessions, refresh the view, expand/collapse, print options 

and save order 

 Clipboard - quickly reschedule Appointments 

From the Command menu select Collapse All  to show all columns on screen. Expand 

All reverts to the default view. 

Alternatively, select each column's owner individually to expand/collapse. Appointments 

can still be booked and updated as usual. 

 

Default filters can also be applied per user to the Reception view. 

See - Navigating the Reception View on page 44, Preferences Filter on 
page 9 and Appointment Status - Overview on page 77. 
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Make a Special Booking 

1. From the Reception view or Free slot search, select a free slot.  

The appointment slot  locks to other users, and the booking form displays. 

2. Tick the Special Booking box. 

 

3. Enter the patients name into the Special booking title box. 

4. Optionally, choose Booking method from the drop-down list. 

5. Record contact details and any notes about the appointment in the comments box. 

6. In the booking form you can also: 

 Change the appointment duration 

 Change the slot type 

7. Select Book to make the appointment. 

8. A message displays confirming the booking. 

 

 

9. In the appointments list a blue star  displays to the right of the name to 

indicate this is a special booking. 

See - Free Slot Search - Overview on page 55, Reception View and Apply 
or Edit Filters on page 80. 
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Book an Appointment 

1. From the Reception view or Free slot search, select a free slot.  

The appointment slot  locks for other users, and the booking form displays. 

2. Enter the patients Surname and/or Date of Birth into the Patient name box . 

 

 

Note - Local Practice next to the appointment, indicates this is at your practice, 

it is not an indication of branch or main site. Future releases of Appointments will 

include the ability to a make appointments for patients in a cluster or shared care 

organisation - subject to the setting up of sharing agreements. 

Patient Search Criteria 

  Surname 

  Surname, Forename  

  Surname Date of Birth (full or partial) 

  Date of Birth Full 

  Surname, forename Date of Birth (full or partial) 

The full date of birth can be typed as: 

  DDMMYYYY (e.g. 09121980) 

  DDMMMYYYY (e.g. 09DEC1980) 

The partial date of birth can be entered as: 

  YYYY (1980) 

  MMYYYY (091980) 

  MMMYYYY (DEC1980) 

3. Select the Search  button. 
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4. Select the patient from the results. 

 

 

The results detail the patient's registered practice, Local practice indicates the 

patient is on your list. 

The next release of Appointments will include the ability to a make appointments 

for patients in a cluster or shared care organisation - subject to the setting up of 

sharing agreements. 

5. The booking form populates the patient details.  

 

 

The following options are available: 

 Change the appointment duration 

 Change the slot type 

 Add Appointment comments 

 View/update the Patient related notes. See - Patient View - Patient Notes 

on page 21. 

 View Appointment warnings 

 View future and previous appointment status  

 Select the buttons for further information 

The time period for the appointment history is set in preferences. See - 

Preferences - Patient Data on page 13. 

6. Select Book  to make the appointment.  

A message displays confirming the booking. 
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See - Free Slot Search - Overview on page 55, Reception View and Apply 
or Edit Filters on page 80. 
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Booking Multiple Consecutive Appointments 

The Reception view supports the booking of multiple consecutive appointments, for 

example, a patient requires a diabetic review for 30 minutes.  

To book multiple appointments: 

1. Right click on each of the free slots you want to book. 

 

2. The toolbar at the top of the screen activates. 

 

3. Select Book multiple  from the toolbar. 

The Booking form displays.  

Note - The Book Multiple button is only activate when you select more than one 

slot. 

4. Enter the patient's Surname and or Date of Birth into the Patient name box. 

Note - For a list of specific searching options select  on the booking form 

or see Patient Search Criteria on page 58. 

5. Select  Search.  

6. Optionally, check the tick box to include inactive patients in your search, this is a 

user specific setting that remains until changed. 

7. Select the patient from the results. 

8. Optionally, update the Appointment Comments box. 

9. Select Book  to make the appointment. 

The appointment displays and the overrun slots are removed from view. 
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Extend Duration 

The appointment time can be extended from the booking form, by updating the duration. 

1. Select the appointment slot. 

2. Choose a patient or record special booking details. 

3. Change the duration of the appointment, in the booking form. 

 

4. A prompt displays at the top of the booking form - The proposed duration for 

this appointment overlaps with another appointment/slot. 

 

5. Select Book   to make the appointment. 

An alert displays Booking overruns free slots. 

6. Choose either:  

 Replace Slots - this removes the overrun slots from the view. 

 Keep Slots - leaves the overrun slots in the view, the slots are greyed out 

to indicate they are not available. 

 

The Receptionview updates. 

See - Book an Appointment on page 50. 
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Free Slot Search - Overview 

The Reception view has the Free Slot Search option. This is a fast way to book 

appointments, the view includes a free slot count for today and subsequent days. 

The Free Slot Search views have the following features: 

 

 Search by slot duration 

 Filter by AM or PM 

 Current filter from the Reception view remains active 

 Filter can be refined 

 Free slot count by day 

 Access to clipboard - drag appointment from the clipboard to a free slot 

 Information about the current view 

View Options 
There are 3 display settings, defined in preferences: 
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Calendar Style 

 Shows free slot count by Clinician 

 Expand Clinician/Clinic to view free slots 

 

List Style 

 Ordered by start time or a range of times 

across a date 

 All free slots available for the selected 

date - subject to filters 

 Hover over colour to see slot type 
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See - Using Free Slot Search on page 64. 
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Patient Search Criteria 

You can search for a patient using the following options: 

  Surname 

  Surname, Forename 

Note - There must be a comma between Surname and Forename. 

  Surname Date of Birth (full or partial) 

  Date of Birth (Full) 

  Surname, forename date of birth (full or partial) 

The full date of birth can be typed as: 

  DDMMYYYY (e.g. 09121980) 

  DDMMMYYYY (e.g. 09DEC1980) 

The partial date of birth can be typed as: 

  YYYY (1980) 

  MMYYYY (091980) 

  MMMYYYY (DEC1980) 

Note - The surname and forename can be full or partial.  

This information can be found on any search screen where  displays. 
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Patient Warnings 

When a patient has a warning set in Consultation Manager a red alert displays, select 

to view the warning message.  

 

The Patient warning alert displays after the patient's name and is visible in the 

following places: 

Reception and 

 Current appointment views. 

 
Patient view on the demographic 

banner:  

 
Appointment Booking Form 

 

If "Show Discreet" is set, a Show Warning text box displays - select to view the 

Patient Warning. 
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Appointment Warnings 

When making appointments, you may see the following warnings on the booking form: 

Patient already has an appointment on this date 
If your patient already has an existing appointment on the same day the message 

'Patient already has an appointment on this date' displays. 

 

You can either: 

 Book the appointment as normal. 

 Select the future appointments button on the booking form to cancel the other 

appointment. 

This slot conflicts with another appointment / slot 
When you book an appointment and change the duration of the slot, the alert 'The 

proposed duration for this appointment overlaps with another 

appointment/slot' displays.  

If you want to proceed, book the appointment as normal. 

 

Note - The warnings do not stop you making an appointment. 

Ignore Days Prior Restriction 
If a slot has a restriction, for example, Book on the Day, you must tick the 'Ignore 

"Days Prior" restriction (X days)' to make the appointment. 
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Print an Appointment Label 

If your practice has a LabelTrace printer configured as "Vision_Appointment", you can 

print an appointment label from the appointment booking form. 

 From the booking form select the Book & Print  button to issue the 

label. 

Note - You can use Dymo printers to print labels in Appointments. This printer needs 

some configuration, so please contact Helpline for further assistance. 

http://www.inps.co.uk/vision/partners/labeltrace
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Select a Specific Date 

To navigate to a specific date in the Dashboard or Reception view: 

Date Selector 
The Date Selector at the top of the screen lets you pick a date this week, or navigate 

forwards/backwards seven days. 

 

Calendar 
Select the Calendar button at the top of the screen. 
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If the date you require is further forward, use the arrows either side of the month to 

navigate, and select the date. 

When you have finished choose Today from the Navigation menu, to return to today. 
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Using Free Slot Search 

The Free Slot Search quickly finds free appointments. 

1. Select the Free slot search  button. 

2. The selection of free appointments display, maintaining existing filters. 

Refine the results by: 

 Search by duration 

 Edit or apply filters 

See - Apply or Edit Filters on page 80. 

 AM or PM 

 Week Skipper - move forwards +1+/2/+3/+4/+5+6 weeks or return to 

today 

 Use the arrows to display additional appointments, or select an alternate 

date 

 

Note - There are 3 different view options, these are defined in preferences. 

3. Select a slot to book an appointment. 

The booking form displays. 

4. Enter the patient's details into the Patient name box. 
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Patient Search Criteria 

  Surname 

  Surname, Forename  

Note - You must include a comma between surname and forename. 

  Surname Date of Birth (full or partial) 

  Date of Birth Full 

  Surname, forename Date of Birth (full or partial) 

The full date of birth can be typed as: 

  DDMMYYYY (e.g. 09121980) 

  DDMMMYYYY (e.g. 09DEC1980) 

The partial date of birth can be typed as: 

  YYYY (1980) 

  MMYYYY (091980) 

  MMMYYYY (DEC1980) 

5. Select the Search  button 

6. Select the patient from the results. 

The booking form populates with the patient's details.  

7. Complete the Booking Form. 
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Booking Form Options 

 Change the appointment duration 

 Change the slot type 

 Add Appointment comments 

 View / update the Patient related notes. See - Patient View - Patient Notes 

on page 21. 

 View Appointment warnings. See - Patient Warnings on page 59. 

 View future and previous appointment status 

 

Select the buttons for further information 

 DNA's in the last 6 Months 

 Scheduled Appointments 

 Completed appointments 

 Cancelled appointments 

The time period for the appointment history is set in preferences. See - 

Preferences - Patient Data on page 13. 

8. Select Book to make the appointment. 

A message displays confirming the booking. 
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See - Free Slot Search - Overview on page 55 and Preferences - Patient 
Data on page 13. 
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Cancel an Appointment 

To cancel a single or multiple appointment in the Reception or Current appointments 

views: 

1. Right click on the appointment(s) you want to cancel. 

The selected slot(s) are highlighted, and the toolbar activates at the top of the 

view. 

 

2. Select Cancel Appointment  from the toolbar. 

3. Choose a Cancellation reason from the drop-down list. 

 

4. Select Yes to proceed. 

The view refreshes and the appointment slot is available for booking. 

See - Move Appointments on page 75. 
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Change Slot Types 

You can change the slot type in the Reception and Current appointments views for 

both single and multiple appointments, for example, making more emergency 

appointments following a Bank Holiday.  

1. Right click on each appointment to select. 

 

'XX items selected'  prompt displays at the bottom right of the 

screen confirming the number of items selected and the toolbar activates at the 

top of the screen.  

2. Select the Change type  button from the toolbar. 

A list of slot types displays. 

3. Choose the slot type, for example, Emergency from the list. 

 

The slots automatically update and change to Emergency. 
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Copy Appointments  

To make another appointment for a patient, you can copy their existing appointment 

from the Reception or Current appointments view. 

Note - Copying an appointment copies the patient information only and excludes any 

appointment comments. 

1. Right click on the appointment to select. 

 

 The toolbar displays at the top of the screen. 

2. Select the Copy  button from the tool bar. 

Note - In the Reception view - to copy the appointment to a slot on the same 

day, press CTRL and use drag and drop. 

If you are in the Current appointments view open the Reception view. 

3. Select the Clipboard  button. 

The clipboard displays Copied appointments. 

 

4. Select the copied appointment, drag and drop into a free slot. 

The booking confirmation message displays. 

 

Note - the Appointment remains on the clipboard until you either close the app, or copy 

another appointment to the clipboard. 

 

See - Move Appointments on page 75 and Cancel an Appointment on 
page 68. 
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Delete Slots  

Blank slots can be deleted from the Reception view. 

1. Right click on each slot you want to delete. 

 

A pop up confirms how many items are selected, and the toolbar at the top of the 

screen activates. 

 

2. From the toolbar, select the Delete slot  button. 

3. A message displays "Slots(s) will be permanently deleted."  

4. Select Delete  to proceed. 

The view refreshes with the slots removed. 

See - Change Slot Types on page 69 and Hold Slots on page 72. 
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Hold Slots  

You may need to hold empty appointment slots and this can be done in the Reception 

view. 

1. Right click to highlight appointment slot(s). 

 

'XX items selected' prompt displays at the bottom right of the screen to confirm 

how many items selected, and the toolbar activates at the top of the screen. 

 

2. Select the Hold slot  button. 

3. The appointment status changes to  Held. 

To release Held Slots: 

1. Right click on the Held slots. 

"XX items selected" prompt appears at the bottom right of the screen to confirm 

how many items selected. The toolbar activates at the top of the screen. 

2. Select Release slot  button. 

The view refreshes and the slots are available for booking. 

Note - If the slot is held by you then you can select the appointment and use it as 

normal without releasing first. Anyone else wanting to use a Held appointment 

must have administration rights to Release. 
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Insert Slots  

From the Reception view extra slots can be inserted as required. 

1. Right click to highlight an appointment slot.  

 

The toolbar activates. 

 

2. Select the Insert Slot  button. 

3. Update the time / duration / slot type / number of slots. 

 

Note - The duration of the inserted slot can be different that the default slot 

duration. 

4. Select Save to insert. 

The view refreshes with the additional slots. 

See - Hold Slots on page 72. 
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Make Slots Unavailable 

Users with full rights to the Appointments system can mark slots as Unavailable and 

release these. 

Any slots marked as Unavailable cannot be booked until they are made available again. 

1. From the Reception view, right click on the slot(s) you want to mark as 

Unavailable. 

The selected slot(s) are highlighted, and the toolbar activates at the top of the 

view. 

2. Select the Mark slot unavailable  button. 

Alternatively, for a single slot select the Options menu and choose Mark slot 

unavailable. 

3. The view refreshes and the slot(s) display Unavailable. 

 

If anyone tries to book the slot, a message displays 'Cannot Navigate to 

booking because: Slot is unavailable'. 

 

Release Unavailable Slots 
Only users with full rights to the Appointments system can release Unavailable slots. 

1. From the Reception view, right click on the Unavailable slot(s) you want to 

make Available. 

The selected slot(s) are highlighted, and the toolbar activates at the top of the 

view. 

2. Select the Make slot available  button. 

Alternatively, for a single slot select the Options menu and choose Mark slot 

available. 

The view refreshes and the slot(s) are available for booking. 
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Move Appointments 

To move an appointment in the Reception or Current appointments view. 

1. Right click on the appointment(s) you want to move. 

 

The toolbar at the top of the screen activates. 

2. Select the Move  button. 

Note - in the Reception view, you can move a single appointment to a slot on the 

same day with drag and drop.  

If you are in the Current appointments view, open the Reception view. 

3. Select the Clipboard  button. 

The Moved section displays moved patients. 

4. Find your appointment, then drag and drop the patient to the new slot.  

All the associated comments automatically move to the new date and time. 
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5. A booking confirmation message displays. 

 

See - Copy Appointments on page 70. 
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Appointment Status - Overview 

The Reception, Current appointments and Patient views display the status of a 

patient's appointment using the following icons: 

  

 
Booked 

Once an appointment is confirmed the status defaults to Booked.  

In the booking form the count underneath denotes how many future 

appointments the patient has. 

 
Overdue 

One minute after the appointment time is due the status changes to Overdue 

for ten minutes, then changes to DNA. 

 
Arrived 

When the patient is checked in by reception staff or a self check-in, the status 

changes to Arrived. 

 
In Consultation  

When the clinician starts the consultation the status changes to In 

Consultation. 

 
Seen  

When the clinician completes the consultation the status changes to Seen.  

In the booking form, the count indicates the number of completed 

appointments.  

 DNA  

Ten minutes after the appointment time has elapsed, the status changes to 

DNA.  

In the booking form, the count indicates the number of DNA's in the last 6 

months. The count can be set to pulse as an alert.  

See - Preferences - Patient Data on page 13. 

 
Web Appointment 

Slot bookable by your patients online, or against a booked appointment 

indicates that this was booked online. 
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Available for Web Slots 

Appointments available for patients to book online are identified in Reception view by a 

Globe symbol. 

 The available for web slots can be booked as normal by reception staff. 

 Any slot booked online by a patient displays the Globe icon next to the status. 

  

The configuration and distribution of Reserved for Web slots can be managed with 

either Appointments Setup or within Vision 3 Appointments.  

http://help.visionhealth.co.uk/Appointments_new/backoffice/1.0/content/home.htm
http://help.visionhealth.co.uk/DLM550/Appointments/index.htm#39346
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Check a Patient in on Arrival 

A patient can be booked in from the Reception or Current appointments view.  

When a clinician starts and ends a consultation the status updates automatically. 

 To mark a patient as arrived press the  Booked appointment status.  

The status updates to  Arrived.  

 You can also right click on the appointment, select Change Status from the menu, 

and choose a status from the drop down list: 

 

View Status Times 
In the Reception select the patient's name to access the booking form.  

In the Current appointments view the waiting time displays next to the status. 

 

Note - Practices that have Self Check-in screens for their patients will see the 

appointment status update automatically as the patient checks in. 

 

See - Appointment Status - Overview on page 77. 
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Apply or Edit Filters 

The Filter at the top right of the screen enables you to refine the Reception, Current 

appointments and Free slot search views.  

You can save your own filters, and create practice wide filters. 

A default filter can also be set per user - see Preferences Filter on page 9. 

Access the Filters 

1. Select the Filter  button.  

If the Filter is orange  an existing filter is active, hover over the filter to see 

the details or right click and choose Clear filter. 

 

Note - A tick displays next to the active filter name. 

2. Filters can be applied to the following categories:  

 Gender 

 Spoken Language 

 Clinician  

 Clinic 

 Slot Types  

 Sessions 

Note - Any clinics or clinicians that are marked as inactive book owners, and have 

appointments, are indicated by a "strike through". Any inactive book owners 

without appointments are not displayed. 

3. Select a category heading to expand, for example, languages. 
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4. Select from the available options. 

As the languages for example, are chosen, the count of clinicians updates 

automatically. 

5. Select additional categories as required. 

6. Select Run  to apply the filter.  

Save the Filter 
The filter can be saved for future use. 

1. Follow steps 1-5 above. 

2. Select the Save  button.  

3. Enter the Filter Name in the box. 

 

4. To make the filter practice wide, tick the box. 

5. Select Save and apply to use the filter immediately. 
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Note - You can set a filter as a default in preferences. 

Reorder the Columns in the Reception View 
If required you can reorder the columns in the Reception view, by dragging the 

columns. 

1. To save the new column order, you must save the filter - see Save the Filter on 

page 81. 

2. Select the columns and drag into the preferred order. 

3. Select the Command Menu in the top right corner. 

 

4. Choose Save Order. 

The order applies to the filter. 

Note - Saved Filters are accessed by right clicking the filter icon. 

 

See - Saved Filters on page 87, Preferences Filter on page 9 and Clear 
Filters on page 83. 
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Clear Filters 

If the filter is orange  it indicates a filter is already active. 

1. Select the Filter  button. 

2. Choose the Clear  button at the top of the screen. 

The filter is removed and the view refreshes. 

Right Click Filter Options 

 

 Clear filter 

 Delete personal and practice wide filters 

Note - Practice wide filters are indicated by a House  symbol 

 

See - Apply or Edit Filters on page 80 and Delete Filters on page 84. 
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Delete Filters 

If a filter is no longer required it can be deleted. 

1. Right click on the Filter  button. 

2. Select Delete  next to the filter you wish to remove 

The filter is removed. 

 

Note - Practice Wide Filters  can only be deleted if you have admin rights.  

 

See - Apply or Edit Filters on page 80 and Saved Filters on page 87. 
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Practice Wide Filters 

Your practice can have shared filters. 

Only members of staff with admin rights can create practice wide filters. 

To set a Practice Wide Filter: 

1. Select the Filter  button. 

If the Filter is orange  it means an existing filter is active. See - Clear Filters 

on page 83. 

2. Filters can be applied to the following categories:  

 Gender 

 Spoken Language 

 Clinician  

 Clinic 

 Slot Types  

 Sessions 

Note - Any clinics or clinicians that are marked as inactive book owners, and have 

appointments, are indicated by a "strike through". Any inactive book owners 

without appointments are not displayed. 

  

3. Select a category heading to expand, for example, languages. 
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4. Choose from the available options. 

As the options are chosen, the number of clinicians updates automatically. 

5. Select additional categories as required. 

6. Select Save . 

7. Enter the Filter Name in the box. 

 

8. Tick the Practice Wide filter option. 

9. Select Save and apply to use the new filter immediately or Save.  

When you right click on Filter you can see any practice wide filters that have been 

set. These are identified with a House  symbol.  

10. Optionally, you can reorder the columns in the Reception view, then from the 

Command menu, select Save Order. 

This saves the order of columns to the filter settings. 

  

Note - You can only delete a practice wide filter if you have sufficient admin rights. 

 

See - Saved Filters on page 87, Preferences Filter on page 9 and Clear 
Filters on page 83. 
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Saved Filters 

Saved filters are stored and accessed by right clicking the Filter  button.  

A list displays showing your individual filters and any practice filters.  

 To run a saved filter, simply select it from the drop down list. 

 

 Select the Bin  to delete a saved filter. 

Note - Practice wide filters can only be deleted by users with admin rights. 

 

See - Clear Filters on page 83 and Apply or Edit Filters on page 80. 
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Search for Special Bookings 

You can search for Special Bookings: 

1. From anywhere on the Reception views, press F3 or start typing the patients 

name or booking, and the search box displays. 

 

2. The search defaults to the last used search. 

Select the Special Bookings Search tab. 

3. Enter the details, for example, HGV. 

 

4. Update the dates as required. 

5. Select Search . 

The results display. 

6. Optionally, enter additional information to refine the results further. 

 

7. Choose the patient or booking from the list. 

The booking form opens.  

8. Select Save or Cancel to close. 
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Results - Display and Filter Options 
The search results screen has two display options: 

  - Tile view: 

 

  - List view: 

 

See - Make a Special Booking on page 49. 



  

90 

Add Sessions 

Sessions can be added and deleted as required in the Reception view. 

1. Navigate to the date you wish to add a session. 

2. Select the Command menu from the top right of the Reception view. 

 

3. Select Add Session. 

The Add Single Session window displays. 

4. Select the book Owner from the drop down list. 

 

5. Select the Session from the drop down list. 

6. Enter the start time of the session. 

Note - This must be after the current time, if the session is for today. 

7. Select Save. 

The view updates with the new session. 

Note - If the new session clashes with an existing session, an error displays 

"Unable to Add Session". Select OK to return to the Add Single Session pop up 

to select a new time. 

 

See - Delete Session on page 91. 
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Delete Session 

Sessions can be added and removed on an ad hoc basis within the Reception view. 

1. Navigate to the session you want to remove. 

2. Hover the mouse over the session heading to activate the Options menu. 

 

3. Select the Options button. 

The menu displays. 

4. Choose Delete Session. 

 

A pop up warning displays "Session will be permanently deleted and any 

appointments placed on the clipboard". 

5. Select Delete to proceed. 

 

6. The view refreshes, with the session removed. 

All the booked appointments move to the Clipboard . 

See - Add Sessions on page 90 and Move Appointments on page 75. 
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Emergency Evacuation Report 

The Emergency Evacuation Report details by clinician, the patients in consultation, and 

those the waiting room. 

1. From the Reception view select the Emergency Evacuation  button. 

2. The report generates to your default printer, and includes the time of 

generation.
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Print Appointments Lists 

You can print a report which details all the appointments booked for the day you are 

viewing. 

1. From the Reception view, select the Command menu. 

 

2. Choose Print Appointments. 

The printer dialogue displays. 

3. Choose your printer. 

4. Select Print. 

5. The list includes Patient/Special Booking Name with date of birth and NHS Number, 

Slot Type, Contact Details and Comments. 
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See - Emergency Evacuation Report on page 92. 
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Help topics 

Welcome to the Appointments Help Centre 

1 - Getting Started 

Accessing Appointments on page 6 

Appointments Explained on page 7 

2 - Navigating the Views 

Appointment Views on page 37 

Navigating the Reception View on page 44 

Weekly View on page 30 

Dashboard View on page 42 

Current Appointments View on page 40 

Accessing Patient Details View on page 15 

3 - Making Appointments 

Patient Search Criteria on page 58 

Book an Appointment on page 50 

Booking Multiple Consecutive Appointments on page 53 

Make a Special Booking on page 49 

Extend Duration on page 54 

Free Slot Search - Overview on page 55 

Patient Warnings on page 59 

Appointment Warnings on page 60 

Print an Appointment Label on page 61 

Select a Specific Date on page 62 

4 - Edit Appointments 

Cancel an Appointment on page 68 

Change Slot Types on page 69 

Copy Appointments on page 70 

Delete Slots on page 71 

Hold Slots on page 72 

Insert Slots on page 73 

Make Slots Unavailable on page 74 

Move Appointments on page 75 

5 - Appointment Status 

Appointment Status - Overview on page 77 
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Available for Web Slots on page 78 

Check a Patient in on Arrival on page 79 

6 - Filtering Views 

Apply or Edit Filters on page 80 

Clear Filters on page 83 

Delete Filters on page 84 

Practice Wide Filters on page 85 

Saved Filters on page 87 

7 - Special Bookings 

Make a Special Booking on page 49 

Search for Special Bookings on page 88 

8 - Sessions 

Add Sessions on page 90 

Delete Session on page 91 

9 - Reports 

Emergency Evacuation Report on page 92 

Print Appointments Lists on page 93 
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